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Installation 
 
Installing the Software 
 
The software can be installed on a PC running Windows® 7/8.1/10/11 32 or 64 bit.  
 

 
 
To install the LGRemote double-click the installer that can be found on the memory stick or that 
can be downloaded from our website https://www.laseranimation.com. 
 
You will be guided through the installation process. 
When the installation is finished, you might be asked to restart the PC. 
 
 
Featured Programs: 
 

• LGRemote 
Program for remote controlling the Lasergraph DSP from a PC via network. 
 

• LGServer 
Program for handling devices connected to the PC which are to be available to the 
Lasergraph DSP over the network. 
 

• LGPreview 
Program to see the output of the Lasergraph DSP and/or to play back Lpv-files. 
 

• LGTimecode 
Application which displays the timecode received or generated by the Lasergraph DSP 
from/into the network. 

 

 

 

https://www.laseranimation.com/
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LGRemote 
 
Starting LGRemote 
 
To start the application double-click the icon on the desktop or start it from the Windows® Start 
menu. A window will open and show you all available Lasergraph DSPs (if the network is set up 
properly and at least one Lasergraph DSP is connected). 
 
An explanation on how to set up the network can be found in the chapter "Network Setup" of the 
Mark 2 (Lasergraph DSP) manual. 
 
Now choose the Lasergraph DSP you want to connect to and confirm by clicking on "Connect". 
 

 
 
LGRemote will display the user interface of the Lasergraph DSP.  
 
It will start in full screen mode if the desktop resolution of the Lasergraph DSP is the same as the 
resolution of the PC screen. To switch to window mode use the shortcut <Alt>+<Return>. 
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Main 
 

 
 
In the main menu you can 
 
- clear all recent connections, 
- connect to a recently connected Lasergraph DSP, 
- exit the application. 
 
 
 
Connect 
 
Opens a dialog where you can select the Lasergraph DSP you want to connect to. 
Shortcut:  <Alt>+<F1> 
 
 
 
Reconnect 
 
Connects to the last connected Lasergraph DSP. 
 
 
 
Disconnect 
 
Closes the connection. 
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Modes 
 

 
 
Auto Reconnect 
 
When this option is activated, an interrupted connection to a remote controlled Lasergraph DSP in 
the network will be restored as soon as the connection is available again. 
In addition, other users cannot access a Lasergraph DSP via network if it is already in use. 
 
 
External Connect 
 
When this option is activated, an external application (like ShowLine) can select the Lasergraph DSP 
that LGRemote is connected to. 
 
In addition, the Lasergraph DSP can then also be selected via OSC. 
In order to use this, an OSC-string must be sent to port 8000 with the following address: 
 
 /Connect 
 
The string must contain the name of the Lasergraph DSP to which LGRemote should connect to, or 
its IP address. 
 
 
Passive 
 
If passive mode is activated you can only see the user interface without being able to work on it. 
 
 
Full Screen 
 
This will switch the application into full screen mode. 
Shortcut:  <Alt>+<Return> 
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Exclusive access mode 
 
If a Lasergraph DSP Workstation is equipped with a local graphics card, the Exclusive access 
mode disables the local display as long as LGRemote is connected. 
The following message will be displayed on the local display instead: 
 

Remote control active... 
Hit any key for local access 

 
 
Hide Pointer (for touch screens) 
 
This option can be used to hide the mouse pointer when using a touch screen. 
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Select unicode font (fixed) 
Select unicode font (proportional) 
 
Unicode is a system used to capture the characters and elements of all known writing cultures. 
Depending on the Windows® version used, the following steps may be necessary once in order to 
guarantee a faultless display of unicode characters:  
 
• After starting LGRemote select the register "Mode" in the program window and in the drop 

down menu select "Select unicode font (fixed)" resp. "Select unicode font (proportional)". 
 
• A character set which is suitable for the fixed font (which for instance is used in the input line) 

might for example be "MS Mincho". 
 

 
 

 
• An example of a proportional font (which for instance is used in the global text table) would be 

"MS PMincho", see fig.: 
 

 
 
The loading process of the font takes a certain amount of time.  
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If the fonts "MS Mincho" or "MS PMincho" are not listed in the font selection dialog you may have 
to do the following steps first: 
 

Windows® XP: 
Open the "Control Panel" and select "Regional and Language Options" -> "Language". 
Click on "Install files for East Asian languages". 

 
Windows® Vista (or later): 

Open the "Control Panel" and select "Appearance and Personalization" -> "Fonts". 
Search for "MS Mincho" resp. "MS PMincho", select it and click on "Show": 
 

 
 
 
 
If for example Japanese characters are to be entered, the input can be switched on the PC as usual. 
The remote-controlled Lasergraph DSP now displays Asiatic characters. 
 
This selection has to be made once, it will be automatically stored. 
 
 
Note: 
This Unicode selection is only used for the display of Unicode characters in the user interface. 
To use Unicode in a “RunningText” or in the word generator in the “Piced” you have to select a 
Lasergraph DSP font that contains the desired characters (e.g. “Unicode.catl”). 
 
 
 
 
Optimize Window 
 
This command sets the LGRemote window into the best position on the PC screen. 
Shortcut:  <Alt>+<Return> 



Version 2024/02/16 LGRemote Manual 

 

 
 
 
LaserAnimation Sollinger GmbH    Crellestr. 19/20    D-10827 Berlin Page 12 
Phone  +49 (30) 780 963 00   Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com   Internet  http://www.laseranimation.com 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved 

Super Preview 
 

 
 
Enable 
 
If this option is enabled, the preview window will display a simulated laser picture, which can be 
both a screen or a beam projection in combination with simulated fog. 
 
 
Additional DSPs 
 
Here you can select one or more additional Lasergraph DSPs. 
 
The preview of these Lasergraph DSPs will be displayed in the Super Preview window in addition to 
the preview of the currently connected Lasergraph DSP. 
 
The result is similar to the output of the separate application LGPreview. This has the advantage 
that size and position of the preview window are controlled by the Lasergraph DSP GUI. 
 
 
Full Screen  
 
This command will give you a full screen preview. 
Return to "normal" display by pressing the <ESC> key. 
 
 
Infos 
 
If this option is enabled you will see some additional information inside the preview window. 
By default this option is disabled. 
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Info Select  
 
Here you can choose from 3 different sets of information that are shown inside the  
Super Preview window: 
 

DSP Timecode 
This is not the SMPTE, MIDI or the Internal Timecode. 
This is the time that has passed since a film was started. 
  
Laser Fps 
This displays the frame rate of the scanning.  
 
PC Fps 
This displays the PC Graphic refresh rate. 

  
 
Properties (Super Preview Parameters) 
 
Opens the Super Preview Parameters. 
 

 
 
For details see the chapter "Super Preview". 
 
Note: 
OpenGL support of the PC graphics card is required in order to use the Super Preview. 
 
 
Reset Properties 
 
Resets all parameters to default. 
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Cut 
 
Deletes a pasted preview picture. 
 
 
Copy  
 
Copies the current preview window to the clipboard. 
 
 
Paste 
 
Pastes the clipboard content into the preview window. 
 
 
 



Version 2024/02/16 LGRemote Manual 

 

 
 
 
LaserAnimation Sollinger GmbH    Crellestr. 19/20    D-10827 Berlin Page 15 
Phone  +49 (30) 780 963 00   Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com   Internet  http://www.laseranimation.com 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved 

Specials  
 

 
 
 
Netboot 
 
The netboot server reacts to a Lasergraph DSP compact demanding system software. 
This can be the case after a failed attempt to update the software. 
 

Open window 
Opens the output window of the netboot server. 
 
Enabled 
For turning the server on and off. 
 
Rom image filename 
Can be used to select the desired system software (ROM file). 

 
 
 
IP Configuration 
 
This special command opens a window to change the IP Configuration of a Lasergraph DSP or any 
other device that supports this mechanism. 
 

 
 
To change the IP configuration of a device, select the device, enter the new IP address and subnet 
mask, and click OK. 
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Date and Time 
 
This menu item opens a window displaying the current "Date" and "Time" of the connected  
Lasergraph DSP: 
 

 
 
Using the button "Synchronize with PC" sets the date and the time of the connected  
Lasergraph DSP according to the PC clock. 
 
“Set to dedicated time" opens a further window where you can set the date and time manually: 
 

 
 
Note: 
To set the date and time by LGRemote requires a Lasergraph DSP System Software Version 
2008/11/28 or newer. 
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Help 
 
In the Help menu you will find the info about the LGRemote application. 
 
 
 
Mouse Emulator 
 
If for any reason a mouse is missing or does not work correctly, it is possible to  
use the keyboard to move the mouse pointer. 
 
To enable the mouse emulator disable numlock (Num) on the keyboard of the PC.  
The mouse pointer can then be controlled with the numeric key pad: 

 
<1>  mouse downwards left 
<2>  mouse downwards 
<3>  mouse downwards right 
<4>  mouse to the left 
<6>  mouse to the right 
<7>  mouse upwards left 
<8>  mouse upwards 
<9>  mouse upwards right 
<0> and <÷> left mouse key 
<,> and <*> middle mouse key 
<Enter> and <->  right mouse key 

 
Note: The mouse emulator can only be used in the active window of the LGRemote. 
 
 
 
Command Line Parameters 
 
The LGRemote can be started from the command line or from a shortcut with the following 
parameters:  
 
 LGRemote.exe <name or IP address>  
 
If the name or IP address of a Lasergraph DSP is specified LGRemote will automatically connect to 
this Lasergraph DSP.  
 
Examples: 
 
 LGRemote.exe MyCompact 
 LGRemote.exe 192.168.1.17 
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LGServer 
 
The LGServer is an application that enables the Lasergraph DSP to access the PC as a Media, Midi, 
Tablet and Joystick server. 
 
The LGServer runs in the background and can be accessed via the task bar. 
 

 
 
 
By double-clicking the icon the application window opens. 
 

 
 
 
A red dot will indicate that a "device" is enabled in the configuration. 
The flashing of this dot symbolizes data transmission. 
 
Hide 
This will hide the application window while the LGServer is still running. 
 
Exit  
Exits the LGServer application. 
 
Config 
Opens the configuration window. 
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Configuration window 
 

 
 
 
Enable Midi and Midi timecode: 
Enables the use of Midi (Note On/Off, Control Change, Program Change, Pitch Wheel) and Midi 
Timecode (MTC). 
 

Automatically scan for new Midi devices 
When enabled the LGServer automatically scans for newly connected Midi devices.  
This can be useful if USB-Midi devices are connected after the LGServer has been started. 
 
Note: 
Even when "Automatically scan for new Midi devices" is enabled some devices are not 
recognized correctly. Whether or not this will work depends on the device driver. 

 
 
 
Enable Fader board: 
Enables the use of a Fader board that is connected to a serial port on the PC. 
 
Note: 
DO NOT TRY TO CONNECT A FADER BOARD TO A PC WITHOUT THE APPROPRIATE 
ADAPTOR - THIS COULD DAMAGE THE SERIAL INTERFACE AS WELL AS THE FADER 
BOARD! 
 
If your PC is not equipped with a RS-232 interface, you can use a USB to serial adapter. 
To select a communication port other than “COM1”...”COM8” the name of the port can be 
entered manually (e.g. “COM21”).  
 
 
 
Enable Fader by Midi: 
Enables the control of the Lasergraph DSP Faders by Midi Controllers. 
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Syntax Fader by MIDI: 
Fader 1 (Analog(0)) →  Controller 0    
Fader 2 (Analog(1)) →  Controller 1 
Fader 3 (Analog(2)) →  Controller 2 

↓ ↓ ↓ ↓ 
Fader 32 (Analog(31)) →  Controller 31 

Fader-button 1 (AnalogB(0))  →  Controller 64 
Fader-button 2 (AnalogB(1)) →  Controller 65 
Fader-button 3 (AnalogB(2)) →  Controller 66 

↓ ↓ ↓ ↓ 
Fader-button 32 (AnalogB(31)) →  Controller 95 

 
 
 
Enable Joysticks: 
Enables the use of joysticks that are connected to the PC (gameport). 
 
 
 
Enable CDRom: 
Enables the use of an AUDIO CD that is in the CD-drive of the PC. 
 
 
 
Enable Wav/Avi: 
Enables the use of WAV, MP3, AVI and Midi files. 
 

Browse 
Clicking the browse button will open the Windows® explorer to define one or more files to be 
used as a media file (use the "*.wav" to define all wav files, for example). 

 
Write Access 
When enabled the Lasergraph DSP gets write access to the Wav/Avi share. 

 
 
 
Enable Tablet: 
Enables the use of a tablet that is connected to the PC. 
 
Note: 
The tablet driver only supports the Summagraphics tablet (or compatible)! 
 
If your PC is not equipped with a RS-232 interface, you can use a USB to serial adapter. 
To select a communication port other than “COM1”...”COM8” the name of the port can be 
entered manually (e.g. “COM21”). 
 
 
 
Enable File System Server: 
Enables the use of the File System Server provided by LGServer. 
Shares provided by the File System Server can be accessed by any Lasergraph DSP. 
The File System Server is an alternative to the Windows® SMB server. Its use is recommended 
whenever access to Windows® shares is not possible. 
 
The shares of the File System Server are configured using the button "Configure". 



Version 2024/02/16 LGRemote Manual 

 

 
 
 
LaserAnimation Sollinger GmbH    Crellestr. 19/20    D-10827 Berlin Page 21 
Phone  +49 (30) 780 963 00   Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com   Internet  http://www.laseranimation.com 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved 

 

 
 
To distinguish between Windows® shares and LGServer shares use the following syntax in the File 
mode and in the "File System Client Setup" of the Lasergraph DSP: 
 
 \\computer\share =>  Windows® share 
 \\#computer\share =>  LGServer share 
 
 
 
Save 
Saves the configuration as the default setting. 
 
Use 
Saves the configuration until the application is restarted. 
 
 
 
 
Command Line Parameter 
 
The LGServer can be started from the command line or from a shortcut with the following 
parameter:  
 
 LGServer.exe <option> 
 
Option:  

-v  starts the LGServer visible (not hidden). 
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LGPreview 
 

 
 
Overview 
 
The LGPreview is a separate application that can be found in the program directory. 
 
It combines all features of the SuperPreview and the Lpv Player: You can play back an Lpv-file 
and/or see the output of a Lasergraph DSP. 
 
In addition it has two advanced features that makes it easier to preview more than one Lasergraph 
DSP simultaneously: 
 

1) Selection of more than one Lasergraph DSP 
2) Window stays always on top. 

 
 



Version 2024/02/16 LGRemote Manual 

 

 
 
 
LaserAnimation Sollinger GmbH    Crellestr. 19/20    D-10827 Berlin Page 23 
Phone  +49 (30) 780 963 00   Fax  +49 (30) 780 963 25 
Email  info@laseranimation.com   Internet  http://www.laseranimation.com 
Copyright © LaserAnimation Sollinger GmbH. All rights reserved 

Select DSPs 
 

 
 
This enables you to connect to more than one Lasergraph DSP. 
 

 
 
In the selection window you will see all available Lasergraph DSPs and all Lasergraph DSPs selected 
for preview. 
 
With the "Add -->" / "<-- Remove" buttons you can change the selection. 
 
The "Remember" checkbox will keep the setting for the next startup. 
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Always On Top  
 

 
 
You can find this option in the "View" menu. 
 
If it is enabled it will keep the LGPreview window always on top on your PC screen. 
S hortcut: Ctrl + T  
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TIP: 
With the "Caption/Frame" command you can change the "look" of the preview window. 
S hortcut: Ctrl + M 
 
Switch between 3 designs: 
 

  
 

 

 

 
 
Command Line Parameters 
 
The LGPreview can be started from the command line or from a shortcut with the following 
parameters:  
 
 LGPreview.exe [<options>] [<lpv-file> …] 
 
Options:  

-f starts the LGPreview in full screen mode. 
-o plays the specified Lpv file once and quits the application when finished. 
-t opens the program window with high priority (always on top). 

 
Lpv File: 

One or more Lpv files can be specified. They will be opened automatically. 
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LGTimecode 
 

 
 
The LGTimecode is a helpful application that displays the timecode received or generated by the 
Lasergraph DSP from/into the network. 
 
Especially in multimedia setups you might want to use a separate display as a timecode information 
for all people working together. 
 
Note that only the timecode that is sent over network is displayed. 
 
If the timecode is not sent through the network, e.g. it comes from the LGServer, you can easily 
enable the network streaming by enabling the "write" option in the command "SetTimeMode" in the 
TimeScript of the Lasergraph DSP. 
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Super Preview 
 

 
 
The Super Preview Configuration is used to customize the settings. 
 

 
"Reset all Parameters to Defaults" 
The first icon from the left resets all parameters. 
 

 
"Reset all Parameters to Defaults (Ignore DSP Advanced Parameters)" 
The second icon from the left resets all parameters. 
 

 
"Load Parameters from File" 
Opens a dialog box for loading settings from a previously saved file.  
Note: 
These files can be exchanged between LGRemote, LGPreview, Lpv Player and Lpv Creator. 
 

 
"Save current Parameters to File" 
Opens the dialog box for saving the current settings. This way you can reuse a setting later without 
the trouble of adjusting all values again. The background pictures are also saved with all settings. 
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Input methods: 
 
Checkboxes enable/disable the corresponding option. 
 
To change a value, you can either click once into a parameter, type a value into it and confirm it 
with <return>, or use the "Mouse-poti Mode" by clicking into a value and moving the mouse while 
keeping the mouse button pressed. 
 
As in the Lasergraph DSP user interface, the left mouse button is used for a fast value change, the 
middle mouse button for smooth changes. 
 
 
 
Super Preview Parameters 
 
The configuration window consists of seven different sections: 
 

 
 
- Main 
- Fog 
- OpenGL Setup 
- Background 1 
- Background 2 
- Background 3 
- Background 4 
 
You can open/close each of them by clicking onto the +/- symbol in front of the text. 
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Main 
 

 
 
Overview 
 
Except for the "Line Width", all values here correspond to the settings  you can make on the 
Lasergraph DSP (Advanced Parameters - Super Preview). However, the settings in the LGRemote 
are always effective for all channels. We recommend that you only change the values in special 
circumstances, for instance if you want to change something for all channels. 
Normally you should set the parameters on the Lasergraph DSP Advanced Parameters because this 
is more flexible and values can be set individually for each channel. 
 
The checkboxes can have three states:  

 

 

 
Enable    overwrite setting in the Lasergraph DSP Advanced Parameters 

 

 

  
No change    use setting from the Lasergraph DSP Advanced Parameters 

 

 

 
Disabled    overwrite setting in the Lasergraph DSP Advanced Parameters 

 
 
Line Width 
 
Default: 2 
Defines the thickness of the "beam". 
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Simulate Scanners 
 
This option will enable/disable the simulation of "real scanning projectors". 
This includes the inertia and the brightness differences between straight lines, curves and edges. 
 
 
Graphics 
 
Enables/disables a simulated graphic projection. 
 
 

Intensity 
Changes the brightness of the picture. 
 
Size 
Changes size  X + Y. 
 
Position 
Changes the position of the projection. 
 

  By clicking into the crossed arrows you can change both axes by moving the mouse. 
 
 

Fog 
 
This parameter fills the virtual room with fog. 
 

Intensity 
Changes the brightness of the fog. 
 
Position 
Changes the position of the laser projector. 
 

  By clicking into the crossed arrows you can change both axes by moving the mouse. 
 
 
Beam Detect 
 
With this option, a point with a certain repeat will be displayed as a "beam", a bright line.  
 

Intensity 
Changes the brightness of the detected lines. 
 
Repeat 
Determines the number of repeats needed to detect a point as a "beam". 
This value will be added to the value in the Lasergraph DSP Advanced Parameters. 
For instance, if the value is set to 4 in the Advanced Parameters of the Lasergraph DSP, you can 
change that value to 3 by setting the value to -1 here. 
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Beam Table 
 
This option will simulate scanned beams (trickfilm commands SetBeam and SetBeamTimed) with 
some virtual mirrors. 
 

Intensity 
Changes the brightness of the beams. 

 
 
Fog 
 
 
True 3D Fog 
 
Activating the 3D Fog makes the display of the fog even more realistic. 
However, this might not be supported by all graphics cards. 
Also this can slow down the graphics calculation considerably. 
 
 
Structure 
 
The structure of the fog display can be set on a range from unstructured (0) to fully structured (1). 
 
 
Clouds 
 
Changes the amount of clouds inside the fog: no clouds (0) to maximum clouds (1). 
 
 
Speed 
 
Sets the speed with which the clouds move through the virtual space. 
 
 
Direction 
 
Defines the direction of the cloud movement. 
 
 
Rotate 
 
Defines the rotation of the clouds around the Z-axis. 
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OpenGL Setup 
 
This section allows setting OpenGL parameters. 
 
The standard configuration usually leads to the best display. In individual cases it may be possible to 
improve or accelerate the output by optimizing these parameters for the graphics card. 
 
The program analyses the configuration and tries to determine the optimal settings. These are 
referred to as System Default. If you find a better configuration, this can be saved so that it is 
automatically activated the next time the program is started. This is referred to as Default. 
 
 
Force generic OpenGL driver 
 
This parameter activates the software OpenGL driver provided by Microsoft® Windows®. 
Only use this if display errors occur. In practice this driver is very slow and it may take several 
seconds for a picture to be calculated. 
 
 
Enhanced Line Drawing 
 
When this parameter is activated the lines are drawn in a special mode. 
With some graphics cards this will improve the display. 
 
 
Enhanced Beam Drawing 
 
When this parameter is activated the beams are drawn in a special mode. 
With some graphics cards this will improve the display. 
 
 
Line/Beam Profile 
 
Lines are not cut sharply at the edges, they have a profile. This looks a little more realistic. 
Only works if "Enhanced Line Drawing" is activated. 
 
 
Polygon Smoothing 
 
When this option is supported by the graphics card the picture usually looks clearer and so called 
steps are avoided. This option usually does not make the display slower if it is supported by the 
graphics card. It is therefore superior to the "Global Scene anti-Aliasing" which you may find in the 
setup of your graphics card. Here it also depends on the graphics card if the picture is actually 
improved. 
 
 
True 3D Fog 
 
see chapter -> "Properties - Fog" (Parameter "True 3D Fog") 
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Load Defaults 
 
Stored default values concerning the OpenGL setup are loaded.  
 
 
Save As Defaults 
 
The current OpenGL configuration is saved as the default configuration. 
 
 
Reset To System Default 
 
The OpenGL configuration is reset to its values at delivery. 
 
 
Background 1...4 
 

 
 
Overview 
 
You can integrate up to four background pictures, logos or watermarks into your preview. 
Accepted file formats are JPEG, BMP and PNG (PNG = Portable Network Graphics). 
 
Another possibility for adding pictures to the SuperPreview is to copy the desired picture to the 
clipboard from a graphics editing software with <Ctrl>+<C> and to then add it to SuperPreview as 
a background picture or logo with <Ctrl>+<V>. 
 
 
Load 
 
Activate this checkbox to display the specified background picture. 
Clicking on the button "Load" will open a selection box where you can choose a graphic. 
 

Intensity 
Specify the intensity / brightness of the background picture. 
It often makes sense to reduce the intensity of background pictures or watermarks so that they 
will not interfere with the laser simulation. 
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Size 
Specify the size with this parameter. 
 
Position 
This parameter determines the position of the background picture. 
Usually background pictures will be oriented toward the center.  
At +/-10 you can also "affix" the pictures to one of the edges. 
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Release Notes 
 
 
Version 2024/02/16 
 

Bugs and security issues within the 3rd-party libraries have been fixed. 
 
LGRemote: 
- "IP Configuration" now recognizes more lasers and interfaces. 

 
 
 
Version 2022/06/24 
 

Bugs and security issues within the 3rd-party libraries have been fixed. 
 
LGRemote: 
- The "External Connect" mechanism now also supports OSC. 

 
LGServer: 
- Minor GUI changes. 

 
 
 
Version 2021/07/02 
 

Bugs and security issues within the 3rd-party libraries have been fixed. 
 
LGRemote: 
- The Beam Detection in the Super Preview produced incorrect lines in combination with the 

DisplayZone commands. 
 

LGServer: 
- LGServer can now handle up to 30 Lasergraph DSPs. 

 
LGPreview: 
- The Beam Detection in LGPreview produced incorrect lines in combination with the 

DisplayZone commands. 
 
 
 
Version 2020/12/15 
 

Small bug fixes. 
Improved compatibility with Windows ® 10. 
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Version 2018/12/20 
 

LGRemote: 
- "IP Configuration" can now also be used to configure Lasers, AVB interfaces and other 

devices. 
 
 
 
Version 2016/11/07 
 

LGRemote: 
- New key combination <Ctrl>+<Alt>+<Return> to adapt the desktop resolution of the 

Lasergraph DSP (system software 2016/10/17 or newer) to the screen resolution of the PC. 
 

LGTimecode: 
- LGTimecode now supports Net Timecode with 50fps and 60fps. 

 
 
 
Version 2015/09/04 
 

LGRemote: 
- In connection with the DisplayZone commands output errors could occur in the 

SuperPreview. 
 

LGPreview: 
- In connection with the DisplayZone commands output errors could occur. 

 
LGServer: 
- Shares provided by the File System Server could not be accessed when user name or 

password contained umlauts. 
 
 
 
Version 2015/06/05 
 

LGRemote: 
- New mode "External Connect" allows ShowLine to select the Lasergraph DSP that 

LGRemote is connected to. 
 

LGPreview: 
- Small changes (corresponding to the latest release of Lpv Player and Lpv Creator). 
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Version 2015/03/26 
 

LGRemote: 
- Support for the new parameter "Auto Maximize" in the Super Preview Setup. 

 
LGPreview: 
- Support for the new parameter "Auto Maximize" in the Super Preview Setup. 

 
 
 
Version 2014/09/30 
 

LGRemote: 
- The SuperPreview did not work when the name of the Lasergraph DSP contained 

parentheses. 
 

LGPreview: 
- The connection was refused when the name of the Lasergraph DSP contained parentheses. 

 
 
 
Version 2014/04/09 
 

New installer solves compatibility issues with the 64-bit editions of Windows®. 
 
LGRemote: 
- The tablet driver has been removed. It is still available in the LGServer. 
- "IP configuration" now supports Laser Disable Buttons. 

 
LGServer: 
- The File System Server did not work correctly when the share name contained umlauts. 

 
 
 
Version 2014/01/30 
 

LGServer: 
- The File System Server did not work correctly when the local path contained umlauts. 

 
LGTimecode: 
- LGTimecode now supports Net Timecode with 24fps, 30fps and 100fps. 

 
LGPreview: 
- New predefined resolutions have been added to the menu "View". 
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Version 2013/09/16 
 

LGRemote: 
- Workaround included for a compatibility issue regarding the SuperPreview and CrossOver. 

 
LGServer: 
- New: File System Server. 

 
LGPreview: 
- The redraw issue within the skin frame under Wine has been solved. 

 
 
 
Version 2013/02/22 
 

Some Wine related issues have been solved. 
 
LGServer: 
- Under certain circumstances it was possible that a Midi Control Change command was 

recognized with a considerable delay. 
 
 
 
Version 2012/09/14 
 

Minor changes. 
 
 
 
Version 2011/11/15 
 

LGRemote: 
- New menu item to set the date and the time of the connected Lasergraph DSP. 
- The Super Preview now simulates different scanner types according to the setting in the 

Super Preview Setup of the Lasergraph DSP Mark 2. 
 
LGServer: 
- New option for Midi: "Automatically scan for new Midi devices" 
- New option for Wav/Avi: "Write Access" 

 
LGPreview: 
- The LGPreview now simulates different scanner types according to the setting in the Super 

Preview Setup of the Lasergraph DSP Mark 2. 
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Version 2010/09/06 
 

LGRemote: 
- In addition to the currently selected Lasergraph DSP the preview of additional Lasergraph 

DSPs can be displayed in the Super Preview window. 
 
 
 
Version 2009/01/28 
 

Support for Windows® Vista. 
 
 
 
Version 2008/11/18 
 

LGRemote: 
- The command line tool “LglpConfigCon.exe” has been included into LGRemote GUI. It can 

be accessed using the menu item “Special -> IP configuration”. 
 
LGServer: 
- New configuration “Enable Fader by Midi”. This can be used to emulate fader and fader 

buttons by Midi control change commands. 
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